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USER’S GUIDE MANUAL PDF v1.20 
Welcome to the Vyzex Venom v1.20 User’s Guide manual. Remember to check back at the Vyzor editors forum 
(http://support.vyzor.com) for news of updates to the editor and to this document. 
 
If this is your first experience with a Vyzex editor by Psicraft Designs, welcome! If you have other audio products supplied 
with their own Vyzex editor, it’s still a good idea to check out this manual since the M-Audio Venom is a unique machine with 
many deep features and we’ve customized the Vyzex editor work-flow to suit them. 
 
While we’re on the subject of manuals, you should grab the trusty User Guide that came with your Venom now, crack your 
beverage of choice and give it a quick read-through: Not only does this helpful accessory explain what you need to know 
about Venom and its voice architecture, it also explains a fair amount about the Vyzex editor too – How cool is that? 
 
Since a lot of the details regarding parameter editing with Vyzex is covered in the Venom user guide, we have designed the 
Vyzex user’s guide to provide better detail outside of parameter editing – When read in context of each other, these two user 
guides should provide all the information you need to get making your music.  

What the heck is a ‘Vyzex’? It sounds like eye drops or some kind of prescription drug! 
Vyzex (pronounced ‘Vigh-zex’ or ‘Vai’s ex’ if you play guitar) is Psicraft’s editor/librarian system that runs on current Windows 
and Mac operating systems. Unlike Psicraft’s retail Vyzor (pronounced ‘Vigh-zor’) editors (which also operate as VST/AU 
plug-ins), Vyzex editors are stand-alone programs that are bundled free of charge as part of a hardware product’s support 
software. This doesn’t mean that Vyzex is a ‘lite’ or ‘demo’ version, however: Vyzex editors have more features than most 
retail editor librarian products currently available, and Vyzex Venom proves this point many times over – Especially with the 
release of this version which includes LinkTracker, the Sync Manager and a number of other powerful features not found in 
the 1.0 version of the editor shipped with Venom. 

But what if I want to run the editor as a VST/AU plug-in? 
The plan back when Venom was launched was for Psicraft Designs to release a retail editor (Vyzor Venom) that operated as 
a VST/AU plug-in by May 2011 – Unfortunately, several key firmware features of Venom were changed in the final firmware 
version that was released by Avid in 2011, and these changes rendered Venom unable to receive edit buffer loads without 
shutting off all running patterns/arpeggios and muting its master audio output for a second after any load. With Venom unable 
to automate voice and pattern changes in virtual mode during song playback, much of the usefulness of the VST/AU software 
was cancelled out and the commercial release of this new editor was shelved until such a time as Psicraft could persuade 
Avid to revisit the firmware code and produce an update to resolve the issue. 
 
We at Psicraft Designs remain hopeful that InMusic, the new owners of the M-Audio product line (including Venom) will do 
just this, but realistically we can’t count on it. In the meantime, Psicraft Designs is looking into ways to work around the 
current Venom firmware problems on the off-chance that we can restore the full real-time functionality of our VST/AU Vyzor 
Venom editor. If it is possible, we will do it. 

http://support.vyzor.com/
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What are the minimum requirements for Vyzex Venom? 
 
PC Windows XP, Vista and Windows 7. P4 equivalent Processor and up, 32-bit color graphics and 1024x768 or 

larger display. 64-bit Vista and Windows 7 also supported. 
 

MAC OSX 10.4, 10.5 & 10.6 (Tiger, Leopard & Snow Leopard), Power PC G5 and all Intel Processors. 1024x768 or 
larger display. Vyzex Venom will support Mac OS X 10.7 Lion when it is released and will be updated if 
necessary when this happens in summer 2011. 

  
Venom Firmware Version 1.09 or higher (automatically installed when you upgrade your Venom Driver). 

Update Your Drivers! 

 

First things first, you should install the latest audio and MIDI drivers for Venom on your computer. 
 
Get them here: http://m-audio.com/index.php?do=support&tab=driver 
 
Select ‘Keyboard Series’ and ‘Venom’ in the first two columns, and your Operating System in the third. 

Getting Started 
Connect Venom to your computer with the included USB cable and power them both up. Next, launch the Vyzex Venom 
program to begin the following sequence: 

1. Starting Up 

 

Whenever you run Vyzex Venom, the program will automatically scan 
(AutoSense) for Venom and will then select the correct Venom MIDI In 
and MIDI Out ports to use. 
 
  

 

If your Venom is not detected, then it is very 
likely that your Venom’s global MIDI OUT 
parameter has been accidentally set to ‘KEY’ 
and not ‘USB’ which is a requirement for 
using the USB cable connection with Venom. 
 

 
 

 
 
 

Venom Panel LCD 

 

To set Venom’s MIDI OUT to USB, press the front panel ‘Edit’ button once and then 
play the second G# note on Venom’s Keyboard.  
 
This will toggle the global MIDI OUT parameter between ‘KEY’ and ‘USB’. 
 
Once set to USB, AutoSense will succeed the next time you run the editor. 

http://m-audio.com/index.php?do=support&tab=driver
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2. Getting Data From Venom 

 

Once Venom’s MIDI ports are set up, the program will then GET all 
the editable (user) data from your Venom. 
 
This includes: 
 

• Global Settings 
• Multi Bank B 
• Single Bank C 
• Single Bank D 
• Pattern Bank B 
• All Venom Edit Buffers 

 

3. Rendering Editor 

 

All the data components received in the last step are now loaded and 
rendered. This could take a moment or two depending on the speed of 
your computer. 
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Set Files – Your Venom’s onboard memory made Virtual 
At this point all the data from your Venom will be available for navigation, editing, auditioning and saving to your computer’s 
hard drive and other storage media. These saved files are called Sets, and each one is a ‘backup Venom’ waiting to be 
restored to life as either a ‘virtual Venom’ when loaded in the editor, or as a real Venom when it is transmitted to the Venom 
unit connected to the software. 

Contents of a Vyzex Venom Set (*.SQS) File 

 

Factory Banks 
In the picture above, some of the banks have a black background: If you’ve read the Venom user’s guide by now you’ll know 
that these banks (Single A&B, Multi A and Pattern A) are factory banks, which means you can’t edit the Singles, Patterns 
and Multi data stored in them, nor can you change the order of their contents: These factory banks aren’t transferred by the 
Vyzex editor on start-up since it already knows their contents. The factory banks are stored in each set file created by the 
editor - The Multis you create will almost certainly reference a factory single or pattern, after all. 

Edit Buffers 
Eleven of the components stored in each set file are called edit buffers: There’s a Single Edit Buffer, a Multi Edit Buffer, a 
Pattern Edit Buffer and then four other single and four other pattern edit buffers associated with the Multi edit buffer. These 
edit buffers are where Venom holds sound programs while you are editing them: When you perform any parameter edits, you 
are actually changing this parameter in the appropriate edit buffer, which is allows you to audition the results right away. 
When you STORE an edited single, the changed edit buffer is copied back to the bank location you select as the destination. 

Global Settings 
The last component of any set file is the Global Settings – This is where all the global parameters of your Venom are stored in 
the file. These also come along for the ride when you store a set file to disk. 
 

‘Auditioning’ Explained 
The process of loading a single, pattern or multi to one of Venom’s editing buffers is referred to as Auditioning the sound. 
This makes sense if you think about it from the perspective of your Venom: Every single you load into one of Venom’s editing 
buffers will change Venom’s synthesized sound, and this will be an audible difference. 
 
 
We’ll get deeper into all of these concepts later on in this guide. For now, let’s go for a tour of the editor’s graphical user 
interface (GUI). 
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The Application Window 
When you first run Vyzex Venom, the application window is completely dedicated to the Venom editor GUI: 

 
The ‘Virtual Venom’ shown above is exactly that: It represents all the data within the real Venom connected to the computer. 
 

 

The editor GUI has three mode buttons: Pattern, Multi (shown above) and Single.  
 
All control labels associated these modes are colored as follows: 

• Pattern = Green 
• Multi = Orange 
• Single = Blue 

 
As we step through Venom’s sound architecture, you’ll see that this color-coding system is an 
important aspect of the editor design: Things would get quite confusing if all the labels were black! 

 
When you work with Venom, it will either be in Single mode or in Multi mode. By pressing the Pattern button you can toggle 
either of these main modes into a combined mode that edits Pattern data in the context of the Single or Multi mode.  
 

 

The Multi, Single and Pattern modes all have a related Bank and Store sub-mode:  
 

• Bank mode is where you navigate and edit the banks of the current mode data, and  
• Store mode is how you store edited data into the user bank location(s) of your choice. 

 

 

 
There is also a Global mode in the editor. As you might imagine, this is where you can change the global 
parameters that govern how your Venom operates. 
 

 
The Bank, Store and Global modes act as ‘overlay’ modes – They appear ‘on top’ of the currently active mode until you are 
done bank editing, storing sounds or editing the global data. 
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The Editor Layout 
Now you’ve had an introduction to the mode controls of the editor, let’s take a look at how the rest of the GUI is designed: 

 
 

1. Mode: These controls govern which mode the editor is in. 
 

2. Display: This virtual LCD is where you change programs and rename the one you are editing. It also indicates when 
the current program has been edited (but not stored) and if the editor is in Virtual Bank mode or not. 
 

3. Part/Store: This area is empty when the editor is in Single or Single+Pattern mode, but will alternately show Multi 
Part controls when the editor is in a Multi mode, or the Store Manager controls when a store is underway. 
 

4. Edit:  This area is where the edit controls for the currently selected mode are laid out – When in Single or Multi mode, 
this area shows an EDIT tab that allows you to switch between four Edit Pages specific to the Single or Multi editor.  
 

5. Global: This area edits and displays the global Arp, Clock Tempo, and Octave parameters of Venom. 
 

6. Performance Control: The controls in this area are the virtual equivalent of those within the Performance Control 
block on Venom’s front panel. 

 
The bottom area of the editor GUI has a virtual Pitch Bender, Mod Wheel and 7 Octave MIDI keyboard. These generate and 
display MIDI information but do not edit any Venom data parameters. 
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Venom’s Combined Modes 
As we mentioned earlier, the primary mode buttons (Pattern, Multi & Single) work together to select a combined mode for 
Venom. The editor GUI also features a drop-menu control to allow you to select a combined mode directly.  
 

 
 
As can be seen in the graphic above, the Single mode has one combined mode (Single - Pattern) while the Multi mode has 
eight combined modes, depending on which of the four multi parts are selected and whether the Pattern button has been 
pressed or not. 
 
All of these mode selections show a different editor in the ‘Edit’ section of the GUI. Let’s check them out now! 
 
 



 

Vyzex Venom User’s Guide Manual 8 

Single Mode 

 
Single Mode is actually divided into four specialist pages:  

• OSC : The Oscillators, Mix, Filter, Envelope, Voice and Pitch controls are here. 
• LFO :  The LFO, Insert FX, Channel, Master, EQ are here, along with top level Aux FX type selectors. 
• MOD : Venom’s 16 element Modulation Matrix is here. 
• AUX :  Aux FX 1, Aux FX 2, Arp and File Notes are found here. 

 
The Single editor also appears in Multi Mode as the detailed part editor for singles, but in this context it will also have Source 
Selector controls visible as part of the Multi’s parameter editing requirements. We’ll explore these differences when we get to 
the Multi mode editor, but for now let’s concentrate on the Single mode. 

Rotarist or Linearite? 
When it comes to editing virtual knobs, there are two opposing points of view: There are the Rotarists, who believe that 
virtual knobs should be edited with circular mouse gestures, and their eternal opposition the Linearites who hold true that 
only straight-line mouse gestures should be used to spin virtual knobs. Like many deeply-held belief systems, the Linearite 
doctrine is further divided into those who believe that the linear gestures must be horizontal, and those who believe that only 
the vertical mouse path is the righteous one: ‘Choose ye correctly, or a plague of eternal tendonitis awaits thee’, or so they 
would say in the 12th century, anyway. 
 
Although the Vyzex Venom editor was designed by the Rotarists at Psicraft Designs, the Venom Synthesizer design team 
were mostly Vertical Linearites. As a result, Vyzex Venom is set for Vertical Linear operation as a default1. 
 
If you are not a Vertical Linearite, fear not: The program’s Options->Preferences dialog has a ‘Patch Edit’ tab in which you 
can select between ‘Std Mouse Editing’ (Linearite) and Rotary modes, or simply change the Linearite preference from vertical 
(Up / Down Drag) and horizontal (Left / Right Drag). 
 
If you are using a touch-screen computer, you should try the Rotary option: We believe it’s the best choice for touch gestures. 

                                                      
1 Yes, we were outvoted on this one... Fortunately, the Vyzex manual was written by Rotarists, so you have a choice... ;-) 
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More Helpful Editing Hints 

 

Clicking once or hovering over any control will select it – You can then edit it in ways other than dragging the 
mouse: 
 

1. Mouse wheel is supported: Spin that wheel, it’s waiting for you... 
2. The ‘,’ and ‘.’ keys (which also have ‘<’ and ‘>’ printed on them) work as -1 and +1 commands on the 

currently selected control. This is really useful when performing fine edits. 
3. You can enter text at any time when a control is selected for keyboard entry – The text will need to 

match one of the valid entries in order to work however! 
4. CTRL-SPACE (Windows) and ALT-SPACE (Mac) resets the control to its default (not always 0) value. 

OSC Page 

 
The OSC page is where Venom’s three oscillators are configured, mixed, filtered and enveloped. The controls on this page 
edit the main parameters of Venom’s synthesis engine. 
 

 

For an excellent exploration of Venom’s synthesis engine complete with instructions for using the Single mode 
editor’s OSC page controls, check out the Venom User Guide PDF available from the ‘Manuals’ menu in the 
Vyzex application window. 
 

LFO Page 

 
 
The LFO Page hosts controls to edit Venom’s three Low Frequency Oscillators (LFOs), and it is also where the Amplitude 
Mod (A-MOD) effects, Insert FX, Channel, Master and EQ parameters are controlled for the current single (or Multi Part 
Single). For convenience, there is also an AUX FX panel that lets you toggle Aux FX1 and Aux FX2 on and off. 



 

Vyzex Venom User’s Guide Manual 10 

MOD Page 

 
 
The Mod Page of Vyzex Venom requires some explanation, but we should cover some of the basic concepts of Venom’s 
MOD Matrix first. 
 
As can be seen, there are 16 separate modifiers (Mods) in the matrix. These have a Source, an Amount and a Destination 
parameter. Working together, these parameters define how each mod takes a given source parameter and uses it to change 
(modify) a destination parameter in real-time according to the amount set for the mod. So far so good, but there are a few 
rules to consider in this system: 
 
Mod Matrix Rules 
 

1. No Mod can Modify itself. In other words, Mod 3 cannot select the amount of Mod 3 as its destination.  
 

2. Mods chosen as Destinations cannot be Mod Sources themselves. In other words, when a Mod is chosen as the 
destination of another, this modified mod cannot modify any other Mods2. In other, other words, if Mod 3 has Mod 5’s 
amount as its destination, Mod 5 cannot mod any other Mod amount in the matrix. Got it? Good. 
 

3. Mod 1 and Mod 2 cannot modify the other mod amounts (3-16) at any time – These two mod amounts are controlled 
from the Filter Env Amount and Filter Keytrack performance control knobs on Venom’s front panel (try it!), which 
means they are hard-wired as the Mod Destinations of these controls. According to rule 2, this means they are mod 
destinations and therefore cannot be mod sources. 
 

4. Multiple mods can modify the same destination mod simultaneously. In other words, Mod 4, 8 and 12 can all modify 
Mod 3’s amount if so desired. 
 

5. Monophonic sources can only modify monophonic destinations. Likewise, polyphonic Sources can only modify 
polyphonic destinations. In practical terms, this means that if you select ‘LFO3’ as a mod destination, you will only 
have monophonic sources to choose from. 

 
Fortunately, you don’t need to memorize these rules when working in Vyzex because it will enforce them by adjusting the 
contents of the Source and Destination control pop-up selector lists based on the current state of the Mod Matrix: You will 
notice as you go along how these control pop-up selector lists differ between the Mods in the matrix and change over time 
and now you’ll know why this is happening. 
 

                                                      
2 Also, Peter Piper picked a peck of pickled peppers... 
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The Anatomy of a Modifier 
 

 

As we explained earlier, each modifier consists of a Source, an Amount and a 
Destination.  
 
The Amount parameter scales the incoming Source value and the result is used to either 
modify another Venom parameter (Like Filter Cutoff as shown here) or another Modifier in 
the matrix.  

 
When a modifier’s destination is changed to that of another Mod in the matrix, you’ll see a couple of changes in the Vyzex 
Mod page GUI. Let’s take a look at Mod 6 (above) when we change the destination to ‘Mod 2 Amount’: 
 

 
 

1. Mod 6 is highlighted white in a gray box, indicating that Mod 6 is now a Mod Source. 
 

2. Mod 2 now shows a Mod Source icon (gray box with a white 6). This indicates Mod 6 is modifying Mod 2’s amount. 
 
Since Multiple mods can modify the same destination mod simultaneously (Mod Rule 4), the Mod Source icon system shown 
above can display up to four modulation sources at the same time. Let’s use our example above to select Mods 4, 8 and 12 
as sources for Mod 3. Here is the resulting Mod Matrix in Vyzex: 
 

 
 
Here’s a closer look at Mod 3: 
 

 

There are three Mod Source icons shown in Mod 3 at this time, namely 
Mod 4, Mod 8 and Mod 12. 
 
The layout of the icons and the controls also illustrates how the mod 
operates – In this example, the control output of Mods 4, 8 and 12 are 
added together to produce an offset in real-time that is applied to the 
amount of Mod 3, which is currently set to a default value of 0%. 
 
The resulting Mod amount is multiplied with the Source parameter’s 
current value to get a real-time control value for the Destination parameter. 

 

 

Although the Mod Matrix GUI only shows a maximum of four mod source icons, you are free to assign more 
than four mod sources to a single mod destination – Just be aware that you will only see the four lowest 
numbered mod sources as icons in that destination. 
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AUX Page 

 
 
The AUX page is where you can edit the Aux 1 and Aux 2 effects, edit the Single’s Arp parameters plus view and edit the 
single’s FILE information and search tags. 
 
File Information 
The File Notes allow you to enter reference information such as the Name, Author, Artist, Song, Band and Notes to the 
currently edited single. When this single file is exported and shared, the File Information data will go along for the ride.  
 
File Search Tags 
These four Search Tags allow you to select a value for the Instrument, Source, Timbre and Genre Search Tags. When this 
single file is exported and shared, the File Search Tags will go along for the ride.  
 
 

 

The File section is a special part of the Single editor that allows you to enter your own information and 
descriptive tags about the single – These will be stored within any set file that holds the single, and will also be 
exported to a *.sgl file when you press the ‘Save’ button in the File Notes section. 
 
Also, your Venom does not feature memory space to store the file information or tags aboard the instrument.  
 
As a result, Syncing a single to Venom will not transfer its file information or tags into the unit, and any singles 
you get from your Venom will have these fields completely cleared. 

 
 
File Open, Save & Collect 
 

 

 
The Open button opens a dialog that prompts you to select a .SGL file for loading into 
the current single edit buffer – This will overwrite the currently loaded single. 

  

 

 
The Save button opens a dialog that prompts you to save the current single to a .SGL 
file in the local folder of your choice. 

  

 

The Collect button will store the current single into the Global Collection3, and will 
automatically open the Collection View if it is currently closed. In the event a Single with 
the same name is already in the collection, you will be prompted to decide whether to 
overwrite, rename or cancel the Collection Store operation. 

 
 

                                                      
3 The Global Collection is covered later in this guide. 
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Single (.SGL) files do not contain the pattern referenced by the single. As a result, you may not get the results 
you expect when working with them unless the patterns they referenced when they were saved are still in the 
same locations and remain unchanged from that day. 
 
As a result, you should use Bundle files to back up and share your singles online: This file format includes the 
singles itself and the pattern that it references. We’ll now explain Bundle Files in more detail. 

 

Bundle Files 
As was mentioned next to one of the in the gleaming red icons on the last page, any single (.SGL) file that you save from the 
File Notes section of the Single editor will only contain the single and not the pattern that it references.  
 
Since drum sounds and many of the synthesizer sounds you create for your Venom will work best when paired with a 
particular pattern, Vyzex Venom also includes the ability to save and open Bundle Files. 
 
There are three types of Bundle Files available to Vyzex Venom:  
 

• Single Bundle Files: These contain a single and its associated pattern,  
• Multi Bundle Files: These contain a multi and its four associated singles, plus its four associated patterns. 
• Bank Bundle Files: These contain an entire bank of patterns, singles, or multis. 

 
You can save and open Single Bundle files from the button bar that appears whenever the Single Editor AUX page is 
selected:  
 

 
 
 
 

 

 
 
Single (.SGL) Bundle Files can also be opened and saved from within the Multi Single Part Mode AUX Page of 
each Multi part. This allows you to bundle any desired part of a multi into its own single bundle which you can 
then open when the editor is in Single mode and vice-versa. 
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Pattern Mode 

 
 
Pattern mode in Vyzex Venom is very simple – There is only one page, and this only permits you to edit the Arp settings 
stored in the pattern. The pattern data itself is not editable. 
 
The Reserved for Future Expansion area is where actual pattern editing functions may one day exist. For now, use the 
Venom driver’s included control panel applet to import any .MID file snippet from your personal library or the internet into a 
new pattern for use with your Venom. 
 
Just as with the Single, there is a File Information and Search Tags section plus ‘Open’, ‘Save’ and ‘Collect’  command 
buttons that will import and export single patterns to individual files for online file sharing, or alternatively store these patterns 
to the global collection. 
 
  
 

 

The File section is a special part of the Pattern editor that allows you to enter your own information and search 
tags about the Pattern and Arp – These will be stored within any set file that holds the single, and will also be 
exported to a *.pat file when you press the ‘Save’ button in the File section. 
 
Also, your Venom does not feature memory space to store the File information or tags aboard the instrument. 
As a result, Syncing a pattern to Venom will not transfer its file notes into the unit, and any patterns you get 
from your Venom will have their File information and search tags fields completely cleared. 
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Multi Mode 

 
 
Multi Mode’s top-level editor features a tab control that allows you to choose a specific Multi detail page. These are: 
 

• PARTS: The part specific parameters of each of the four parts are here including MIDI MAP, Control, Voice, Channel, 
Arp, Aux 1, Aux 2 and Master. 
 

• VOICE: The Voice and Channel part override controls are here. 
 

• ARP: Detailed controls for each of the four part’s ARP settings are made here 
 

• AUX: Detailed AUX FX1, Aux FX 2, Master and File Notes are located here. 
  
 
Before we get into the detail pages of the Multi mode, let’s take a moment to look at the extra controls that appear in the 
Parts/Store section of the editor GUI when Multi mode is active: 
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The Multi Navigator 

 

This virtual LCD is specific to the Multi mode when Single 
part editing is active (i.e. the Pattern button is turned off). It 
consists of a part selector control and three columns of 
check box controls that edit the Mute, Enable and Select 
parameters of each part in the multi. 
 
There are actually 5 rows in the part selector – The top row 
selects the Multi editor itself (what we refer to as the top-
level multi editor) while the four numbered rows underneath 
select the corresponding Multi part single editor. 

 

 

 
 
Part names will be ‘ghosted’ in the Multi Navigator when their Enable box is unchecked - See Part 4 (Nightly) in 
the illustration above. 

The Multi Control Panel 

 

This panel of buttons operates exactly the same as the MULTI 
CONTROL panel on your Venom’s front panel. 
 
While these functions duplicate those found in the Multi Navigator, 
they are sometimes easier to use depending on your work-flow4.  

 
 

 

 
 
You will usually see that one of the part buttons in the Multi Control Panel flashes red (alone or alternating with 
green): This is just Vyzex Venom’s way of indicating that the part in question is currently selected for editing, 
which is different from the solid green displayed by a part button that is selected for performance control 
functions.  

 
When in SELECT mode, Venom’s front panel Multi Control buttons allow you to select multiple parts by simultaneously 
holding down the buttons for the desired parts. Since your computer mouse isn’t multi-touch, the editor’s equivalent to this 
capability involves holding down the computer keyboard’s SHIFT key while making the selections. The last part selected will 
be the one specifically loaded for editing as indicated by alternate flashes of red in the button LED. 

 

                                                      
4 Also, when Venom is in Multi+Pattern combination mode, the Multi Navigator is not active so these controls are essential!  
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Inside Venom’s Multi Structure 
If you have read the included Data Management Guide PDF (available from the Vyzex application ‘Manuals’ menu), you are 
already prepared for the tour of the Multi editor pages. If not, you should at least be aware of the following important aspects 
of Venom’s Multi structure before proceeding: 

 
 
In each Multi, there are link parameters that tell Venom which Singles and Patterns to load as each of the four Multi parts.  
 
Each of these nine elements (the multi, four singles and four patterns) are loaded in separate edit buffers and interact with 
each other and you to create the amazing mini-compositions heard when you play the Venom keyboard: 
 

 
 
The obvious consequence of this structure is that each multi depends on four separate singles and four separate patterns to 
sound the way it does – If you delete or move any one of these eight linked elements, the multi will be ‘broken’ in one way or 
another. While this sounds dangerous on the surface, we’ll soon see that Vyzex has two features designed to prevent such 
an unfortunate scenario from happening, namely LinkTracker and the Store Manager. We’ll cover these shortly. 
 
Not so obvious in this diagram is Venom’s flexible system of Source Selectors at the Single and Multi level: For example, 
singles can override the arpeggio settings in the patterns that they link to, or simply use the pattern’s built in arpeggio 
parameters. This allows the single to ‘customize’ how the pattern plays back with the single without changing the built in 
pattern arp settings that are available to other singles and multis.  
 
Similarly, any multi can override a number of the parameter sections in its linked singles such as the Voice, Channel, Arp and 
FX sections – By using these source selection parameters wisely, a multi can ‘customize’ each linked single and pattern for 
use as part of the multi without changing the ‘built in’ parameters that work when the single or pattern is loaded by itself. 
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Panel Swapping: How Source Selection Works within the Vyzex Multi Editor 
If you have read the last section of this guide, you should already appreciate the sophistication of Venom’s multi linked 
structure and the creative flexibility of the Source selectors at each level. 
  
Make no mistake, however – All this flexibility can make things very confusing without an up-front understanding of what is 
actually going on in the editor’s user interface. In light of this fact, we are going to take a moment to point out one of the 
aspects of the Vyzex Multi Editor called ‘Panel Swapping’. 
 
The Multi Navigator manages five separate editor windows stacked as shown here: 
 

 
 
The Top Level Multi and the four Multi Part Single editors are stacked in the same order as the rows of the Multi Navigator 
control. It’s as if the whole stack is a 5-storey building, and the Multi Navigator is the elevator control panel: To edit a Part 4 
parameter you would travel to the bottom floor, and to edit top-level multi parameter you would take the elevator up to the top 
floor.  
 
While this obvious way of visualizing how the Vyzex Multi editor operates is a useful metaphor, things are actually a bit more 
complicated because of Venom’s Source Selectors: 
 

 

In Multi mode, there are a number of source selectors to deal with – both in the top-level Multi editor and in 
the individual Single part editors. These selectors let you choose a block of parameters at any given level of 
the stack to be the ‘override’ the controls for all other levels. 
 

 
These Source Selectors make it necessary for the editor to swap affected panels within the current level with panels from the 
currently selected source – No matter what level you go to, you’ll only see the currently selected source in that section of the 
floor. 
 
If this sounds confusing, don’t worry – As always we have a couple of oversized graphics and an example to make things 
more understandable... Just turn the page to check them out. 
 



 

Vyzex Venom User’s Guide Manual 19 

Here is the VOICE page of the Top-Level Multi editor with Factory Multi A 000 (Stingray) loaded: 
 

 
 
In this multi, the Voice parameters are all set to use the Multi as their source. Here is how the Vyzex editor displays these 
settings: 

 
 
We’ve framed Part 1’s VOICE panel in red, Part 2’s VOICE panel in blue and Part 3’s VOICE panel in yellow to make it more 
obvious what is going on, namely that the VOICE panels in the top-level multi editor are duplicated within the multi part single 
editors: These duplicated panels have been swapped for their counterparts at each single level editor in the stack. 
 
This panel swapping functionality of the editor also works in reverse: In the example above, the Voice Panels of each of the 
single parts are currently swapped (replaced) by those from the top-level multi. If any part’s Voice Source control was to be 
subsequently changed to a Single source, then it would be the Multi’s Voice part panel that was swapped and you would be 
able to edit that part’s single Voice parameters from the Top-Level Multi editor. 
 
Because of Panel Swapping, you will only ever interact with the currently selected source controls, no matter which level of 
the editor stack you are working in: As a result, you should always pay attention to the color coding of the parameter labels 
and the source selectors... You could be editing the multi when you are in a part editor, or vice versa! 
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The Multi Editor – PARTS Page 

 
 
The PARTS page of the Multi editor is designed to provide an overview of the current multi.  
 
The controls in the MIDI MAP and PARTS-CONTROL sections of this page are only found on this page of the editor, while 
the remaining controls on this page (VOICE, CHANNEL, ARP, AUX FX1, AUX FX2 & MASTER) are actually duplicates of 
those found on other specific pages of the Multi and Single Part editors - These duplicate controls are provided for convenient 
access to the most obvious parameters of each part when you are interactively setting up your multi and auditioning the 
results. For detailed editing of the VOICE, CHANNEL, ARP, AUX FX and MASTER parameters, there are dedicated pages in 
the multi which we will explore later in this guide. 
 
Source Selectors – VOICE, CHANNEL & ARP 
Source Selectors in the PARTS page of the multi editor look like buttons but they require a double-click mouse operation to 
activate. They operate like this to prevent accidental source editing, incidentally. 
 

 

The VOICE, CHANNEL and ARP Source Selectors only have two choices – Multi or Single. 
When you select Single as the source, you are choosing the Single associated with the part 
control. In the example here, Part 1 is using and editing the Multi Voice parameters, while Part 2 
is using and editing the Voice parameters in the part 2 single. 

 

 

 
 
In the VOICE, CHANNEL and ARP sections, a part cannot select the SINGLE parameters of any other part. In 
other words, Part 1 cannot use Part 3’s SINGLE parameters. 

 
 
Source Selectors – AUX FX 1, AUX FX 2 & MASTER 

 
 
 

 

 
Unlike the VOICE, CHANNEL and ARP Source Selectors, these three Source Selectors have 
five choices (as shown here). 
 
This means your multi can use the Aux FX 1 settings from any part’s linked single, or use the 
settings stored directly in the multi. The same holds true for the AUX FX 2 settings and the 
MASTER settings. 

 



 

Vyzex Venom User’s Guide Manual 21 

The Multi Editor – VOICE Page 

 
 
The VOICE page of the multi editor also includes the CHANNEL parameter controls of the multi. These control the same 
parameters as seen in the PARTS page, but in greater graphical detail. 
 
As was discussed earlier in this guide, selecting any part to have a SINGLE source will swap that particular VOICE or 
CHANNEL panel with the one from the appropriate part. Also, if any part row is ghosted (like part 4 in the example above), 
this indicates that the part has not been enabled in the Multi. 
 

The Multi Editor – ARP Page 

 
 
The ARP page of the multi editor allows you to edit pattern selection and arpeggio parameters for all four Multi parts. Since 
the Pattern editors of Vyzex Venom only offer arpeggio parameter editing, this page of the Multi editor is actually a better 
place to edit from since you have access to all four parts simultaneously. 
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The Multi Editor – AUX Page 

 
 
The AUX page of the Multi editor resembles the AUX page of the Single editor with the following exceptions: 
 

1. Instead of an ARP detail there is a MASTER detail 
2. Instead of Single File Notes there is a Multi File Notes section. 
3. There is a handy MIX section that lets you balance all the levels of each part in the multi. These controls duplicate 

parameters found elsewhere in the Multi editor, but here they are grouped together in one convenient place. 
 
Just as we saw in the PARTS page, the three Source Selectors in the AUX FX 1, AUX FX 2 and MASTER panel sections 
have five choices- You can choose the multi or any of the four parts as the source for use within the current Multi, and these 
panels will be swapped into every corresponding editor in the Multi stack. 
 
Multi File Command Buttons 
 

 

 
The Open button opens a dialog that prompts you to select a .MLT file for loading into 
the current Multi edit buffer – This will overwrite the currently loaded Multi. 

  

 

 
The Save button opens a dialog that prompts you to save the current Multi to a .MLT file 
in the local folder of your choice. 

  

 

The Collect button will store the current Multi into the Global Collection5, and will 
automatically open the Collection View if it is currently closed. In the event a Multi with 
the same name is already in the collection, you will be prompted to decide whether to 
overwrite, rename or cancel the Collection Store operation. 

 
 
 
 

 

 
Multi (.MLT) files do not contain the patterns or the singles referenced by the multi. As a result, you may not get 
the results you expect when working with them unless all of the singles and patterns they referenced when they 
were Collected are still in the same locations and remain unchanged from that day. 
 
As a result, you should use Bundle files to back up and share your multis online: This file format includes all of 
the singles and patterns that your Multi will reference. 

 

                                                      
5 The Global Collection is covered later in this guide. 
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The Multi Part Editors 

 
 
When Vyzex Venom is in Multi Mode and you select a part for editing (either from the MULTI PART buttons or the Multi 
Navigator), you’ll see the Single editor is loaded into the editor area of the GUI.  
 
In the context of Multi Part editing there is one significant change to note in the Single editor: The editor panels now include 
Source Selectors where appropriate so Panel Swapping will be active based on these selections. For example, in the 
screen capture above the VOICE panel’s Source selector is set to Multi, and therefore the block of controls in the Voice area 
edit the Multi Part 1 parameters (their labels and knob graphics are orange to indicate this). 
 
Aside from this key difference, you will find that each Multi Part Single editor behaves exactly the same as the Single Editor, 
although they obviously edit the multi part singles instead of the Single loaded when Venom is in Single mode. 
 
Working with Single Bundle Files in Multi Part Editors 
As we mentioned earlier in this guide, Single bundle files can be saved whenever Vyzex is in Single mode and the AUX page 
has been selected. This is also true when Vyzex is showing one of the four Multi-Part editors and the AUX page has been 
selected. 
 
Single bundles created from one of the multi-part editors are file compatible with those created from the single editor. In other 
words, you can open single bundles as parts of your current multi, and you can save parts of your current multi as single 
bundles to be opened later as singles on their own. 
 
This capability can also be used to transfer single-pattern combinations between parts of the same multi, or to transfer them 
between multis – Simply create the bundle file in one part and then reopen it from another. 
 

 

 
Because of their flexible nature, bundle files have 2 extensions: 
 

• Single Bundles use the .SGL.SQB double extension, and 
• Multi Bundles use the .MLT.SQB double extension. 
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Disabled Multi Parts 

 
 
As we have seen on the preceding pages of this guide, disabled parts and their names are frequently displayed as ‘ghosted’ 
graphics and text – This approach makes sense for small numbers of controls when they become irrelevant based on some 
other parameter choice, but this is not how Vyzex Venom handles entirely disabled parts.  
 
Rather than ‘ghost’ the editor for any disabled part, disabled part panels are instead outlined in grey and labelled as disabled: 
This leaves you free to make changes to the part even if you currently cannot hear their effect – When the part is eventually 
enabled all these changes will be heard at once. 
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Bank Mode  

 
 
Bank mode is an ‘overlay’ mode that rides on top of the currently selected primary mode: The Single Bank mode is shown 
above, but there are two others... 
 
This is Multi Bank mode, 
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And this is Pattern Bank mode: 

 
As you can see, the three bank modes look quite familiar aside from the fact that Single Bank mode offers four banks to 
choose from instead of the two found in the Multi Bank and Pattern Bank modes. 

LinkTracker: Link Icons 

 

You may have noticed that many of the Single and Pattern Bank entries in the 
illustrations above have small circle-shaped icons next to them: These are called Link 
Icons, and they are one aspect of a great new editor feature called LinkTracker. 
 
Whenever you see a Single with a Link Icon, you’ll know that at least one Multi is using it 
as a part. 
  
Similarly, when you see a Pattern with a Link Icon, you’ll know that at least one Multi or 
Single is using it as a drum pattern or arpeggio. 
 
Since Multis are never linked by singles or patterns, you won’t ever see a multi bank 
entry with a Link Icon.  

 

When you see a Link Icon next to any single or pattern entry, this means the single or pattern is required by 
another sound within your current set of Venom data. 
 
On the other hand, any element without a Link Icon can be moved or deleted without consequence to other 
sounds. 
 

LinkTracker: Status Bar 
While Link Icons are useful to see which singles and patterns are in use by other multis and singles, this feature would be of 
limited benefit if there was no way to also know at a glance which multis and singles were using the linked element.  
 
This is why there is a context-sensitive LinkTracker Status Bar as part of the bank editor layout. Hover the mouse over any 
bank element to see the status bar appear: 
 

 
 
Not only does the Status Bar show which multis use the currently hovered single, the status bar also shows the pattern that is 
used by the single. In the example above, Two different multis (B-93 BasLayer08 and B-95 BasLayer10) rely on Nasal Bass 
as a single part, and Nasal Bass in turn relies on pattern A-9 New Hats for its groove data. 
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LinkTracker: Automatic Link Update 
While Link Icons and the Status Bar display all the link dependencies of any hovered bank element, these capabilities would 
not make creating and organizing Venom data much easier if you still had to worry about manually updating links in the 
displayed multis and singles every time you moved or swapped around patterns for example – This is why LinkTracker 
automatically updates the displayed multis and singles whenever you move or swap a pattern in the user bank:  
 
You can drag and drop singles and patterns all around the user banks without any concern for the multis and singles that 
depend on them – LinkTracker will automatically edit and store these referenced elements for you – A very nice feature! 

LinkTracker Warnings 
So far we have shown that the Automatic Link Update feature of Vyzex Venom prevents you from damaging multis and 
singles whenever you copy, swap and move around any singles and patterns these larger structures might have linked for 
use as parts.  
 
For swap actions, these protections all you are going to need to prevent problems elsewhere in your sound library – Data is 
only being moved around, and since LinkTracker is automatically updating the links whenever this happens there is no 
danger of data loss.  
 
Copy actions are another story, however: When you copy one multi, single or preset to a new location, that new location’s old 
resident gets cleared to make room for the copy – And this will damage any number of multis or singles that might rely on that 
location holding the original data. 
 
This is where LinkTracker Warnings come into play: These are enabled by default and will provide you with an ‘are you 
sure’ dialog if you are ever going to copy over a single or pattern that is linked by another multi or single. 
 

 
 
There is no undo for any operations at this level of the program, so be sure before you proceed by pressing the OK button. 
 
 
 

 

The LinkTracker only warns about items that are stored in the bank – The currently edited Multi, Singles and 
Patterns are not tracked. In other words, the program will not warn you if you are about to clear a single or 
pattern that is only linked by the currently selected multi or single.  
 

 
 
 
If you find the LinkTracker’s warnings irritating or intrusive to your workflow, LinkTracker Warnings can be disabled from the 
Store Manager Display that becomes visible whenever you press the STORE button on Venom’s front panel or the GUI. We’ll 
cover the Store Manager later on in this guide. 
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Direct & Virtual Bank Editing  
Whenever Venom and the editor are fully synchronized with each other, the editor will operate in ‘Direct Bank’ mode: What 
you see in the Bank windows is exactly what is stored in Venom’s on-board bank memory. 
 
If the editor loads new Multi, Single or Preset data from disk, it will no longer be in ‘SYNC’ with your Venom. When this 
happens, the editor will show the file contents as a ‘Virtual Bank’ and will work to simulate how these banks would behave if 
they were actually loaded aboard your Venom – You’ll see that load times for singles and Multis take a little longer in this 
operational mode. 
 

 

 
 
A comprehensive explanation of Direct and Virtual Bank editing can be found in the included ‘Data 
Management Guide’ PDF available for instant reading from the program’s ‘Manuals’ menu. 
 

 
The Bank Editor is a view into one of the banks of 128 Venom singles (or multis or patterns) that are currently open in the 
editor. You can:  
 

1. Select new singles for editing by clicking on them, 
2. Reorganize the singles within the editor’s bank area with drag and drop operations, and  
3. Send and receive selected singles to and from your Venom if the editor is in Virtual Bank Mode.  

 
If Vyzex Venom is in Direct Bank mode, any changes you make to the bank order will automatically be performed on Venom 
as soon as they happen in the editor. 
 

Bank Drag and Drop Operations 
By default, drag and drop will swap the source single (or Multi or Pattern) with the destination. CTRL-C (Option-C on Mac) will 
copy the current selection to the clipboard and CTRL-V (Option-V on Mac) will paste it back over any new selections you 
make; SHIFT-Drag will insert the source after the destination, and it will also move back the bank entries in between the two 
in order to fill the hole left behind by the source.  
 
 

 

Multiple entries in a single selection cannot be dragged and dropped. You should use the copy and paste 
features of the program when you need to move more than one adjacent single to a new place. 
 
Also, you must choose the same number of singles you copied for the paste destination, or the operation will 
not work. 
 

The editor’s bank modes also come equipped with ‘Copy Selected To’ and ‘Swap Selected With’ command buttons that are 
designed to work with selections of any size and shape: 

 
The ‘Copy Selected’ and ‘Swap Selected’ buttons will become visible when any selection has been made.  
 
Press the command button and then click on the desired destination bank button to complete the operation. 
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Virtual Bank Editing Controls 
If Virtual Bank mode or Virtual Bank Override mode is active, and you have selected any programs in a User Bank, you’ll see 
two controls become visible in the lower left corner of the bank mode edit area. 

 

 

 
The GET SELECTED button will get the selected programs (which will be multis, 
singles or patterns depending on the bank) from Venom, overwriting the current 
selection in the editor. 
 
The SEND SELECTED button will perform the opposite operation – The selected 
programs will be sent to Venom, overwriting the matching selection in Venom’s flash 
RAM. 

 
The Benefits of Virtual Bank Mode 
When the editor is working in Virtual Bank mode, you are operating on copies of single, Multi and Pattern data from your 
Venom, and not on the original data itself. This means you are free to rewrite the currently loaded set in the editor window 
from top to bottom and unless you SEND the User Bank back to the Venom at the end of your session, your two original user 
banks of 128 singles, user bank of 128 multis and user bank of 128 patterns on board your Venom will remain safely 
untouched. 
 
Likewise, when you load a single, multi or pattern for editing through the Vyzex GUI, only Venom’s editing buffers are 
updated with the edited sound data. This allows Venom to constantly ‘audition’ your changes to the current sound so you can 
test out each edit you make in real-time. Unless you press the SEND SELECTED button in the bank editor GUI, the edited 
single, multi or pattern will not be written to your Venom’s ‘permanent’ memory in its onboard User Single, Multi and Pattern 
Banks. 
 
There are two major advantages to the Virtual Bank approach that are not possible in Direct Bank mode: 
 

1. Venom’s user banks are protected from accidental overwriting at all times, and 
 

2. Every set file you load into the editor gives your Venom an entirely new set of user banks right away. 
 

Whether in direct or virtual bank mode, you can also safely ‘audition’ any program from any part of the software by single-
clicking on entries within the user banks or the collection view (which we’ll cover later on). 
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The Patch Collider 
As you make selections in the user banks, you will see buttons become active in the PATCH COLLIDER area of the bank 
editor. 

 
 
The Patch Collider is a very cool feature of Vyzex Venom – Think of it as your very own parameter scrambling particle 
accelerator that allows you to take one or more source singles and smash them into each other at relativistic speeds, 
producing new and exciting sounds (and theoretically a few harmless micro-miniature black holes too)6. 

 

 
 

Visible when 2 or 
more singles are 

selected 

 
The MIX ALL button creates a new Bank of Singles by randomly picking parameters from 2 or more 
selected singles. The probability of the parameter coming from each of the selected singles is equal. 
 
Each new single is a random combination of the selected singles. 
 

 
 
In the example shown here, nine singles have been selected in the bank editor and the MIX ALL button has then been 
clicked, which opens the Patch Audition and Selection dialog. On the left side of this dialog is the patch selector, which 
contains 128 singles that have been automatically generated from the collided parameters of the four selected singles. The 
current selection is auditioned on your Venom, which allows you to quickly step through the entire set of generated singles 
(note that some of them will not produce sound because of their random nature) with your mouse and/or keyboard arrow up 
and down keys to find the ones you’d like to keep. 
 

                                                      
6 If cult science-fiction movies are more to your liking, feel free to call this feature the BrundelPatch Teleporter instead. The effects on the 
patches you run through it are the same – Their parameter DNA gets interchanged and scrambled together to create exciting (and 
sometimes horrific) new creations. 
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You’ll note that the name of each generated single is a random combination of the ‘source’ single names: You are free to 
rename them once you have transferred them to a more permanent location. 
 
 

 

The 128 generated singles will be discarded if you close the dialog without storing any of them to the collection 
or your currently open single bank!  
 
If you leave the ‘Verify Close’ option checked, you will be warned every time you try to close this dialog, but if 
you uncheck this option be advised that any un-stored generated singles will be lost. 
 

Once you have found a generated single you wish to keep, you can either store individually it in the Global Collection with an 
optional new name (see The Collection View)  you can store the entire batch of generated singles into the Global Collection 
by pressing the ‘Store All in Global Collection’ button. 
 
When an entire batch of 128 collided singles are put in the collection, they are automatically named and numbered according 
to which Patch Collider command created them and their order in the created batch. For example: 
 

1. MIX ALL: MA000 to MA127 
2. MIX: MX000 to MX127 
3. BLEND: BL000 to BL127 
4. MORPH: MO000 to MO127 
5. GENERATE 4: G4000 to G4127 

 
These automatic names will keep the batches together in the collection’s alphabetical listing.  
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Visible when 2 singles 
are selected 

 
The MIX button creates a new bank of singles by randomly picking parameters from 2 selected singles. 
 
The probability of any parameter coming from each of the selected source singles is controlled by the 
‘Randomize Options’ dialog: 

 

 
 

 
 

Visible when 2 singles 
are selected 

The BLEND button works similarly as MIX except that it combines larger chunks of data from each 
single thus maintaining more of their overall aural characteristics. Additionally the probability of the 
parameter coming from each of the selected singles is fixed at 50%. 
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Visible when 2 singles are 
selected 

The MORPH button creates a new bank of singles from 2 source singles by incrementally 
transposing the settings of the first single through to the second single's settings. This function is 
ideal if you are trying to find a sound that is somewhere between two given singles. 
 

 
The names of the generated singles and their position in the list indicate how far along the 
morphing has been applied between the two source singles.  

 

 
The MORPH function takes some time to generate the entire bank of 128 singles you get in the dialog above – 
Be prepared to wait for five seconds or so while these are generated! 
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Visible when 4 
singles are selected 

The GENERATE 4 button opens the Patch Generator 4 Dialog, and is active only when you select 4 
singles at the same time. The Patch Generator 4 Dialog creates a bank of new singles by mixing the 
parameters of the four selected singles.  The percentage of each single is determined by the location 
of each of your mouse clicks, as shown here: 
 

 
 
An entirely new single is generated from the selected source singles for each of the mouse clicks that 
you make in this 4-way grid. Once you have entered 128 points (you can drag in the grid to enter 
multiple points quickly), GENERATE 4 will move on to the Patch Audition and Selection dialog where 
you can quickly try out the newly generated singles. 
 

 

 
GENERATE 4 will use either the MIX or BLEND algorithm, depending on your selection in the Patch Generator 
4 dialog above. 
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Global Mode  

 
 
The global mode has controls for configuring Venom’s global parameters – As you might expect, these parameters apply to 
Venom’s operation all the time, no matter which single, multi or pattern you have loaded. 
 
 

Global Mode Display 

 
 
In the global mode’s display shown here, the editor is indicating that... 
 

1. Venom’s global settings are now synchronized (SYNCED) with the editor 
 

2. Direct Bank editing is active: The editor bank views reflect is what is stored within Venom’s onboard bank memory. 
 

3. The editor will always GET the global settings from Venom, even when you open a stored SET file. 
 
The checkbox control in the lower right corner of the display is checked by default when the program is installed – This option 
ensures that any set files you open do not overwrite your personal Venom global settings. 
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Editor Global Options 
 

 

Direct Bank mode is the default for Vyzex Venom when you install it.  
 
Even when you have Direct Bank mode selected, Vyzex Venom will go into ‘Virtual 
Bank Override’ mode if you open a set file from disk: This is because this new set will 
almost certainly be different to the contents of your Venom’s onboard flash ram. 
 
When Virtual Bank Override is active, the Virtual Bank text in the display area of the 
editor will flash. Also, you’ll see that the Virtual Bank selector in the Global Edit area is 
flashing red and some warning text also appears to let you know what is going on. 
 
The only way to cancel the Virtual Bank Override is to put Venom back into full 
synchronization with the editor. 

 
 
 

 

 

Another editor option that is active by default is Check For Updates on Launch: Whenever you launch 
Vyzex Venom it will notify you if a newer version is available and provide a link to download it. You can 
disable this feature by un-checking the box. 
 
NOTE: Un-checking and re-checking the checkbox will command the editor to check for updates every time the box is checked. 

The Sync Manager 
In order to fully explain the SYNC manager feature of Vyzex Venom, we are going to borrow a graphic from the included 
‘Data Management Guide’ PDF included in the Vyzex Venom manual set: 
 

 
 
For Direct Bank Editing to be possible, the contents of the user banks in Venom must exactly match the user banks in the 
Vyzex editor. When this is true, each user bank is said to be synchronized, or SYNCED for short. 
 
Whenever the user banks are not synced between Venom and the editor, Virtual Bank editing is active – Since the bank 
elements in the editor are likely different to those stored in Venom, the editor does not automatically write them to Venom’s 
matching bank. Instead, the editor only loads the selected element to Venom’s appropriate edit buffer for instant auditioning. 
 



 

Vyzex Venom User’s Guide Manual 37 

 
Here is what the Global LCD area looks like in Direct Bank mode when all the user banks are SYNCED: 

 
 
Here is the Global LCD area when a file is first opened from disk – The editor user banks are UNSYNCED with those on 
board Venom and so Virtual Bank mode is active. To show this, another LCD screen also appears called the Sync Manager: 
 

 
 
The Sync Manager provides visual feedback to the user banks that are not synchronized: If you wish to return the editor to 
direct mode operation, these banks need to be SYNCED first – That’s all there is to it! 

Sending/Getting a User Bank 

 

When a user bank is UNSYNCED, there are two ways to restore synchronization 
between the editor and Venom: The editor can send the bank to Venom, or the 
editor can get the bank from Venom. 
 
Clicking on the direction arrow (or the boxes marked VENOM and EDITOR) will 
flip the SYNC direction from SEND to GET and vice-versa. 
 
Once you have chosen the SYNC direction, press the SEND/GET button below.  

 
 
When a SYNC operation is underway, the main area of the Global editor will switch to SYNC MANAGER progress display: 

 
In the GET operation above, all the user Multis in the currently open set are being replaced by the user Multis from Venom. 
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On completion of the SYNC operation the Sync Manager display will update to show the new SYNC state of the bank: 

 
 
Once a user bank is Synced, the SYNC direction control and GET/SEND button for that bank will disappear from the SYNC 
manager, and you’ll see a ‘VENOM = EDITOR’ display graphic in their place. Sync the rest and Direct Bank editing will 
resume. 

Sending All User Banks 

 

In many situations you will be opening a set file from disk in order to restore your Venom’s user banks to a 
known backup state. In these situations, the quickest way to get the job done is to click on the arrow-shaped 
‘SEND ALL BANKS’ button shown here: The editor will set all user banks to ‘SEND’ and will begin 
transferring the set to your Venom immediately. 
 

 
 

 

Send operations will replace your Venom’s user banks: Their contents will be wiped out (cleared, zilched, 
erased, de-rezzed, oblivionized... well, you get the picture).  
 
Use the Sync Manager with care since there is no undo from a SEND unless you have wisely backed up your 
Venom’s user banks earlier on with the editor. 

 
 
The Sync Manager will remain visible as long as there remains an unsynchronized user bank in the current set or as long as 
you have the editor configured to work in Virtual Bank mode.  
 
Once full synchronization is achieved between the editor and Venom’s user banks, any Virtual Bank mode override will end 
and the editor will snap back into Direct Bank editing mode. The Sync Manager will then disappear from the Global editor until 
you need it again. 
 

Getting All User Banks 
There is no dedicated ‘GET ALL BANKS’ button in the Sync Manager – This is because choosing ‘File->New’ from the 
application menu will have the exact same results and you’ll get a newly initialized file and name to work with as well. 
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Performance Control 

 
 
This section of the Vyzex Venom GUI operates exactly like the PERFORMANCE CONTROL section of your Venom’s front 
panel: Select a row in the performance control matrix with the UP/DOWN buttons and you’ll see the labels underneath the 
four knobs updating to reflect your selection. 
 
Any interactions you have with the actual PERFORMANCE CONTROL panel on Venom will be reflected in the editor’s 
version, and likewise any mouse edits you make from the editor will (of course) be transmitted to Venom as if you had 
performed them from the front panel. 
 
The Knobs and their surrounding ring graphics will reflect the color of the currently controlled parameter – Orange is Multi and 
Blue is Single. 
 
 
Part Control Icons (Multi Mode Only) 

 

 
Unlike Venom’s front panel, the editor’s version of the PERFORMANCE CONTROL section 
also features Part Control Icons: These circular symbols to the left of each performance 
control knob indicate which parts of the multi will be edited when you twist the knob. 
 
For example, this screen capture shows that Filter Cutoff edits done with the Performance 
Control knob are only going to affect Multi Single parts 1, 2 and 3. 
 
When you have selected the MIX parameter row, all performance control knobs will operate 
at the Multi level and the numbers in the part control icons will change from blue to orange in 
order to reflect this choice.  
 

 
 

 

When a Part Control Icon is ‘ghosted’ this indicates that the part it is associated with is currently unselected.  
 
Part Control Icons will show as active for disabled parts if these parts have been selected. This is because 
edits will be performed on the disabled part even though they are not audible. 
 

 
 
About Performance Control Displayed Values... 
Since the Performance Controls on Venom’s front panel use MIDI CC and NRPN messages to change the Single and Multi 
parameters they affect, the editor’s Performance controls do the same: As a result, the displayed values of the performance 
controls on Venom’s front panel LCD (when you interact with the front panel knobs and button) and the displayed values of 
the virtual performance controls in the editor will not always correspond to those shown by the affected parameter. 
 
For example, Filter Cutoff as a performance control has a range of (0-1023), while in the editor it has the much larger range of 
0-16368.  
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The Store Manager  
So far we’ve covered the following aspects of Venom’s sound architecture: 
 

• Singles link to Patterns and that these two elements work together as one sound either in Single mode, or as one of 
the four parts in Multi mode. 
 

• Multis link to four Singles and their linked Patterns. Multis can alternatively link to four other Patterns instead of those 
linked to the four linked Singles. 
 

• Source Selectors exist at the Multi and Single level to control which parameters apply to the currently selected Single 
or Multi. 

 
Although the LinkTracker capability of Vyzex Venom automatically manages these linkages for you when you move, copy 
and paste elements within their bank editors, the LinkTracker only works on items that are already stored in the bank – The 
currently edited Multi, Singles and Patterns are not tracked. 
 
Also, whenever you load a multi for editing, you will inevitably edit parameters within the linked four singles and four patterns 
that are part of the multi’s overall sound – Often without even knowing it. When it is time to store your edits back to the 
respective multi, single and pattern banks of the current Venom set, how will you know which elements have been edited? 
 
You could rely on the ‘EDITED’ indicators in each of the editor modes, but this would not be an ideal way to work: 
 

 

 
The ‘EDITED’ indicator shows that you’ve edited the top-level multi. 
You’ll also need to check each of the four multi-part single editors for 
their ‘EDITED’ icons and then the four multi-part pattern editors for their 
‘EDITED’ icons. Now store each of these separately. 

 
In this scenario you’d literally need to keep track of your edits manually in order to know which parts needed storing. This 
would also mean going through the STORE procedure up to nine times every time you saved an edited multi. If any of your 
source edits were factory presets, you’d also have to take note of which of the single and pattern store operations moved the 
edited sound into a user bank and remember to manually select these new destinations in the multi editor and then store the 
multi a second time update the new part selections. Clearly, a better way is required if you plan to make any music at all with 
your Venom!  
 
This is why Vyzex Venom provides a ‘wizard’ style interface that guides your choices during all store operations. Whenever 
you press the STORE button on Venom’s front panel or within the editor, Vyzex Venom activates the Store Manager and a 
virtual red LCD screen appears in the Part/Store area of the GUI: 
 

 
 
Although it looks a little complicated when you are storing a Multi and all its associated parts, the Store Manager is actually 
very easy to use and quite simple to understand. 
 
 
 
We’ll start off easy by introducing how the Store Manager operates when you store the simplest of all Venom data -  The 
Pattern. 
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The Store Manager in Pattern Mode 

 
 
The simplest form of Store Manager is the one that is launched when you press the Store button while Venom is in Pattern 
mode. In the example shown above, ‘Fast Jump’ hasn’t been edited yet so the EDITED icon in the green display area is 
ghosted out.  
 

 The equals icon in the Store Manager display indicates that the pattern loaded in the green display ‘equals’ the pattern 
shown in the red store destination. No changes have been made and a store is not necessary. Consequently the 
pattern has not been automatically checked for storage (the box next to ‘Fast Jump’ is empty). 

 
Here’s what happens if we edit the pattern while the Store Manager is activated: 
 

 
 
As can be seen, ‘Fast Jump’ is now marked as ‘EDITED’, an arrow icon has replaced the ‘=’ icon, and a user pattern bank 
destination (B 91) has been suggested and checked for storage. 
 

 
The arrow icon in the Store Manager display indicates that a store is necessary and therefore the pattern shown 
underneath has been checked as the storage destination. The Store Manager will store your edited version to the 
pointed location. 
 

If we wanted to, we could double-click on the destination control (showing ‘B 91 Paralyzer’ in this example) and choose a 
different program destination before pressing the Store button a second time to complete the store operation.  
 
 

 

 
You can cancel the Store Manager by pressing the CANCEL button. The Store Manager will also be cancelled 
if you press a different mode button in the editor GUI or on Venom’s front panel. 

 
 
 
If you were to uncheck the pattern store destination before pressing the Store Button a second time, you would see this: 
 

 
 
The destination stays set to the suggested user bank destination (B 91), but now the arrow icon changes to a flashing not 
equal sign. 
 

 
The flashing not equal icon in the Store Manager display indicates that your edited ‘Fast Jump’ pattern originally 
loaded from factory bank A91 doesn’t match the recommended destination ‘Paralyzer’ in user bank B91. The ‘not 
equal’ icon is flashing to warn that if you do not check the box and complete the store operation, your edits will be lost 
when you choose a different pattern for editing. 
 

 



 

Vyzex Venom User’s Guide Manual 42 

The Single Store Manager 
In Single mode, the Store Manager takes on more complexity as it now deals with pattern linking: 
 

 
 
This is actually the same editing example as the one shown in the previous section, only now we have pressed the STORE 
button in Single mode. You’ll note that Single A 000 ‘Venomous’ has been recommended by the Store Manager for storage to 
C0, and Fast Jump is still suggested for storage to B91 Paralyzer.  
 
The Venomous single has not been edited however, so why does the Store Manager suggest it be stored to a user location? 
To find out why, we can uncheck the single Store suggestion and see... 
 

 
 
... A flashing ‘broken link’ icon now appears over the Single destination! ...What’s going on here?  
 

 
The flashing broken link icon in the Store Manager display indicates that since the Fast Jump pattern needs to be 
stored elsewhere (remember that it can’t be stored to the A factory bank), the single will need to be updated to link to 
the new location. In other words, if you don’t store the single it will have a broken link. This is why the Store Manager 
suggests that you store the single (to a user bank location) – The Venomous single will not be able to link to your new 
pattern location unless it also gets stored as a user single in either the Single C or D user banks. 

 

 

 
The Store Manager also allows you to change the name of whatever item is recommended for storage: To 
rename the single, you would click on the large ‘Venomous’ name in the main display, while to rename the 
pattern you would click on the small boxed ‘Fast Jump’ name in the Store Manager display. 

 
The store manager does more than just enforce user bank destinations and warn about singles needing storage because of 
editing or because a linked pattern has been edited and will require moving: The Store Manager also updates the single so 
that its link parameters reference the new pattern location as the store operation is executed. 

The Multi Store Manager 
In Multi mode, the Store Manager goes into full-powered operation: 
 

 
 
Not only does the Store manager track all the singles and patterns in the current multi, it tracks the links between the multi 
and the singles, plus the links between the singles and the patterns. You can also rename any of the singles or patterns 
within the Store Manager display by clicking on their boxed name. 
 
Finally, the Store manager indicates which of the Multi parts are disabled by ‘ghosting’ the controls in these parts. The Store 
Manager will still manage and store these disabled parts since you might want to enable them in the future. 
 
 
Just dig in and do some experimenting for yourself and you’ll see that the Multi Mode Store Manager is not as scary as it 
looks – It certainly beats the alternative of manually tracking the dependencies every time you store a Multi! 
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The Store Manager When Bank Mode is Active 
 
Let’s take a moment to consider the Store Manager in Multi Mode: 
 

 
 
According to the Store Manager, the Multi, two Singles and one Pattern all need to be stored for the currently edited sound to 
be preserved. You can right-click on the destination controls to select different storage locations but there is no way for you to 
know in the context of the store manager if these selections are safe places to use– Perhaps the C-28 Single is used by one 
of your other important multis, maybe the B-67 Pattern is too... How can you find out? 
 
One way would be to use the Bank mode’s LinkTracker Status Bar to inspect the links of these elements, but this would 
involve cancelling the Store Manager and navigating to each of the proposed destinations in their respective bank editors and 
then hovering your mouse over them to see their LinkTracker Status Bar information. You would then need to remember this 
information, return to Multi mode and then press the STORE button again to resume the Store Manager.  
 
We think that would be far more trouble than it was worth! Accordingly, the Store Manager has its own edition of the 
LinkTracker Status Bar that can do all of this for you.  
 
To see the Store Manager’s LinkTracker Status Bar in action... 
  

1. Press the editor’s BANK button (or have the editor in a BANK mode overlay) while the Store Manager is active, 
 

2. Hover the mouse over any one of the Store Manager’s destination controls (They don’t need to be highlighted). 
 
You’ll see the LinkTracker Status Bar appear where it normally does in the bank editor, but it will be the same shade of red as 
the Store Manager instead of its usual light green.  
 
The Store Manager LinkTracker Status Bar will show the LinkTracker information for the current element you are hovering 
over, even if this item is not the same data type being shown in the current bank view: 
 
For example, in the illustration above, the LinkTracker Status bar appears in the current Multi Bank editor, but it displays... 
 
... A Multi when the ‘0 Pit Viper’ control is hovered: 

 
 
... A Single when the ‘113 Bonebreak’ control is hovered: 

 
 
... A Pattern when the ’67 ZunkItUp’ control is hovered: 

 
 
 
The ‘LinkTracker Warnings’ Preference 

 

 

You’ll recall the ‘LinkTracker Warnings’ feature from our earlier exploration of the 
bank editor functionality of Vyzex Venom. These dialogs will pop up whenever 
you attempt to overwrite an existing single or pattern that is already linked by a 
multi or another single. You can toggle this feature on and off from within the 
Store Manager 

 
 

 

Every element store that is executed by the Store Manager will be subject to LinkTracker Warnings popping up 
for confirmation when you press STORE to close the Store Manager. 
 
Because the preference control is part of the Store Manager design, you can disable these warnings before a 
Store Manager completion to speed things up... Just remember to turn them on again when you are done! 
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The SET File View 
Because Set Files are so important, there is an optional view to the application called the Set File View. This view is 
activated from the application’s Options Menu: Simply check the Set File View item and you’ll see this ‘side-car’ view open 
to the left of the editor GUI. 
 

 
 
Any Set files you save will be shown in this view – Simply double-click on any entry to load it into the Vyzex Editor. 
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The MIDI Monitor 
There may be times when you want to see the MIDI messages that are being generated by Vyzex and/or your Venom as part 
of their communications. In times like these, the MIDI Monitor is there for you: Simply check the MIDI Monitor item in the 
Options pull-down and you’ll see this ‘side-car’ view open on the bottom of the editor GUI. 
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The Collection View 
The collection view is the most useful of the three optional views: The collection acts as a global listing of your favorite singles 
and multis that remains available no matter which set file you have currently opened. This property makes the Collection View 
as equally useful as both a transfer clipboard and a master library of individual set components. Just like the bank view, the 
collection view automatically loads any selection you make for instant editing – This means you should be careful to store 
your currently edited bank single before you select any item in the collection. 
 

 
 
To transfer any bank entry to the Collection, simply drag it from the Bank window into the Collection. Likewise to transfer a 
collection entry to the editor, simply drag it back into the editor.  
 
If you want to copy the currently loaded single to the Collection, hold down the ALT key and click down the mouse on any 
area in the editor where there isn’t a control and ALT-drag the single to the Collection. 
 
There are a couple of rules governing the drag and drop operations that are possible between the Collection and the Editor 
GUI, and we’ll get into them later on when we cover the Editor GUI in greater detail. 
 
When you first install Vyzex Venom, the Collection will be empty. Then as you add items to it from the Editor, the Collection 
will add them sequentially, although the whole collection will be reordered alphabetically when you click on the Name heading 
bar (Windows) or whenever you reopen the program (Mac).  
 
 

 

The entire collection is stored as a single file on your hard drive called Default.SQC: If you ever want to 
archive the collection, this is the file to back up.  
 
The Default.SQC file is located in the \Psicraft\Vyzex Venom\M-Audio Venom subfolder of your user 
documents folder (on both Windows and Mac). 
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The File Notes & Venom Synth Website 
 

 
 
The File Notes panel of the Single, Multi and Pattern modes lets you view (and edit) the program’s extra information such as 
the Long Name, Song, Author, Band, Artist, and Notes data. Here is a closer look: 
 

 
 
This additional information is saved along with the program parameter data into the editor’s single bank when you Store the 
single, which means it will be stored as part of the set file when you choose File->Save Set from the Vyzex application menu. 
 
The file notes are also exported whenever you save the current single as a single (*.sgl) file by pressing the Save button in 
the File Notes, and any .SGL file you open will also bring its file notes into the current single slot. 
 
 

 

Your Venom does not feature memory space to store the File Notes aboard the instrument.  
 
As a result, Syncing a single to Venom will not transfer its file notes into the unit, and any singles you get from 
your Venom will have their File Notes fields completely cleared. 
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The Venom Synth Website 

 
 
When you are ready to share your single creations online (or want to check out what everyone else has been up to), it is time 
to load up the Venom Synth Website in your web browser of choice. 
 

 

 
You can launch the Venom Synth website in your browser by clicking on the editor program’s Online menu and 
selecting ‘Venom Synth Website’ from the list. 

 
The Venom Synth website is not only the place for you to share your sound creations with the rest of the world – It’s also the 
place for Venom users to get caught up on the latest Venom User Community news, read artist blogs, comment on Venom 
topic forums and generally hang out with other users at all levels of fame and fortune.  
 
 
We recommend you either store your downloads directly to the program’s default data folder. 
 
 

 
 

Vyzex Venom’s default data folder is 
 
/ User / Documents / Psicraft / Vyzex Venom / M-Audio Venom 
 
Where User is your user account name. 
 
This note applies to Windows XP, Vista, Win 7, Mac OS Tiger, Leopard and Snow Leopard alike. 

  
Within this root folder, Vyzex will automatically create and use the following folder system to organize your Venom sound 
data: 
 
M-Audio Venom Multi  
 Pattern  
 Single  
 Bundle Multi 
  Single 
 
 
Set files are stored in the root M-Audio Venom folder. 



 

Vyzex Venom User’s Guide Manual 49 

Opening Single and Multi Files 
While the editor GUI includes an Open button, this is not the only way you can import single files that you have downloaded 
from the Venom Synth website: Before we go deeper into this topic, let’s consider what happens whenever you open a single 
file with the Open button: 
 
 
Whenever you press on the Open button, you are commanding the editor to import the single or multi data as the current edit 
buffer within the current set. Consequently, the following conditions apply: 
 

1. The new single will be loaded for editing, replacing the currently edited single. 
2. The new single will be auditioned on your Venom – Let your ears decide if you want to keep it. 
3. The new single will be lost if you do not STORE (and/or SYNC in Virtual Bank mode) it before selecting another 

single from a user bank or collection. 
 
If you wish to load single files directly into the editor’s user bank or collection view, you can do so by dragging and dropping 
the downloaded file over the appropriate area of the editor GUI: 
 

• Drop the dragged single file over any entry in the bank editor and it will replace that entry, 
• Drop the dragged single file into the collection and it will be added there, 
• Drop the dragged single file into an unused area of the Edit area (such as the SINGLE FILE NOTES title text) and it 

will replace the current edit buffer, just as if you had used the Open button in the SINGLE FILE NOTES panel. 

Opening Bundle Files 
Aside from the fact that Bundle files contain multiple edit buffer data, they open just as as single and multi files do: The 
contents of the bundle file replaces the data within certain edit buffers in the editor so you can hear what they sound like. 
Unless you actually STORE any loaded bundle data into your current set, the bundle data in the editor will be overwritten if 
you select another bank element. 
 
 

 

 
Bundles cannot be collected, but of course their individual components can. For example, a Single Bundle 
File’s single and pattern can be individually collected if you like, but their association together will be broken. 
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Part 8: Configuring Vyzex Venom for Advanced Users 
Congratulations for reading this far along: You have discovered the hidden instructions that explain how to disable the 
program options that were designed with first-time users in mind. 
 
The default options we are about to explore are like the training wheels used when a kid first learns to ride a two-wheeled 
bike. Training wheels protect the first-timer, but they are outgrown quickly and need to be removed to allow the real 
experience of learning to begin. 
 
We’ll now describe what these beginner’s default options are. Instead of just turning them all off, you should consider first 
whether they interfere with how you work – It may turn out that you’ll decide to keep some or even all of them enabled. 

Vyzex Venom Opens All MIDI ports & AutoSenses Every Time It Runs 
The beginning of this guide describes the launch sequence of the program, which involves opening of all MIDI ports attached 
to your computer and then ‘AutoSensing’ which of these MIDI ports is actually attached to Venom. These operations mean 
first-time users never have to worry about configuring which MIDI Ports to use with the editor, and they also allow the 
program to report back if Venom is disconnected, turned off, or otherwise unresponsive before it even attempts to get single 
and global data from the instrument. This is very convenient for beginners, but there are complications that could happen with 
these options turned on: 
 

1. On Windows computers, the class compliant USB MIDI Driver is ‘single-client’. This means any MIDI device that 
relies on the operating system’s USB MIDI capabilities can only be used by one program at a time. If you have other 
MIDI devices that use the Windows USB MIDI driver, these could be grabbed by the Venom editor when it launches 
and will not be available to whatever other software you have. 
 

2. If you have a lot of MIDI devices connected (like several 8-port interfaces for example) the AutoSense routine could 
take a lot of time to complete, which will slow down the program every time you run it. 

 
 
 
 

 

 
Remember: Venom is by M-Audio and comes with some of the most advanced and reliable MIDI device drivers 
available. 
 
In other words: “You don’t need no stinkin’ Windows class compliant USB MIDI and AUDIO driver!” 
 
The first thing you should try if you are having MIDI port access issues with your Venom is to download the 
latest M-Audio Venom drivers for your operating system. Yes... we’re looking at you too, Mr. Latte drinking Mac 
user. Download the latest drivers when in doubt. 

 
 
You can turn these options off, but bear in mind that you will need to manually configure the program to use the Venom MIDI 
port every time your setup changes, which could turn out to be more trouble than having things operate automatically.  
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First, open the MIDI->MIDI In Ports menu item: 
 

 
 
Uncheck the ‘Always Start with All MIDI Ports Open’ option and manually select the ‘Venom Synth’ entry. Click on ‘Ok’ to 
save this change. 
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Next, you must repeat this step for the MIDI->MIDI Out Ports dialog: 
 

 
 
Uncheck the ‘Always Start with All MIDI Ports Open’ option and manually select the ‘Venom Synth Out’ entry. Click on 
‘Ok’ to save this change. 
 
 
 

 

Windows XP users who have not installed the M-Audio MIDI driver7 will not see ‘Venom’ in the ports list – 
Instead they will see ‘USB Audio Device’.  
 
Additonally, multiple class compliant MIDI devices will all be named ‘USB Audio Device’ but will also be 
numbered 1, 2, 3 etc. on Windows XP.   
 
XP users will unfortunately have to work out which USB Audio Device port is Venom by trial and error. 
...Thanks a bunch, Billy! 
 

Once you have configured the program to use a specific MIDI port every time, you won’t need AutoSense on program launch 
anymore, so you might as well turn it off too.  
 

                                                      
7 Hey! Install the M-Audio drivers already! Page 4 of the Venom User Guide is waiting for you... 
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To disable AutoSense on program launch, open the ‘Preferences’ menu item and step to the ‘Studio’ tab: 
 

 
 
Uncheck the ‘AutoSense on Program Execution’ option and press ‘OK’.  
 
That’s all there is to it: From now on the program will not try to AutoSense your Venom on launch. 

 
 
 
 

 

 
 
 
Leave ‘Auto Load Sets’ checked for now: We’ll describe this option in full detail on the following pages. 
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Vyzex Uploads (Gets) Your Venom Data Every Time It Starts 
The next feature for first-time users that you might consider turning off is the automatic ‘Get’ operations that happen every 
time you run the program: Once you have backed up your Venom and created a working .SQS file, the constant reloading of 
Venom data on every start could be a waste of your time, depending how you work. 
 
If you are willing to consider your Venom more like an iPOD and view SYNC operations (From the computer to the Venom) 
as the only type of data transfer you need, then turning off this feature will definitely suit your workflow, provided you don’t 
mind working in Virtual Bank mode all the time and are ready to take responsibility for manually managing the differences 
between your Venom’s onboard user banks and those currently loaded in the editor. 
 
This feature is actually controlled by the ‘Auto Load Sets’ option in the Studio tab, but rather than uncheck this, we are going 
to suggest you leave it on and instead open the ‘Preferences’ menu item and step to the ‘Paths/Misc’ tab: 
 

 
 
In this tab there is an option called ‘Auto Save and Reload Session’. When enabled, this feature remembers the set file you 
had open when you last quit and re-opens this file the next time the program runs.  
 
This feature has a higher priority to the program than the ‘Auto Load Sets’ option in the Studio tab, so when you turn on 
‘Auto Save and Reload Session’ you are also stopping the editor from getting all the data from your Venom every time you 
run the program.  
 
The nice thing about this combination of options is that the program will still GET the single and global data if you create a 
new set file from the File->New menu. 
 

 

 
Enabling ‘Auto Save and Reload Session’ means you’ll need to keep track of any changes to singles that 
were made at gigs through the Venom front panel and remember to manually GET these changed singles back 
to your computer. 
 

 
Running the program this way will also help ensure that you don’t lose any single file notes - These are not stored in Venom’s 
memory so treating the computer file versions as the ‘originals’ and those on Venom as ‘copies’ will prevent the original files 
from being accidentally replaced by copies from Venom that are missing their file notes. 
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Vyzex Uploads (Gets) Your Venom Data Every Time It Creates a New File 
As we mentioned on the previous page, the editor will still automatically get your Venom’s data whenever you create a new 
set file via the File->New menu. 
 
If you don’t want this to happen and would prefer instead a completely initialized set to start with, simply open the 
‘Preferences’ menu item and step to the ‘Studio’ tab: 
 

 
 
Uncheck the ‘Auto Load Sets’ option and press ‘OK’.  
 
Now the program will not ever get data from your Venom automatically. When you open the program it will load the last set 
file you worked on, and if you create a new set it will begin editing with initialized singles, patterns and multis loaded in the 
edit buffers and User Banks.  

But what if I uncheck both: “Auto Load Sets’ and ‘Auto Save and Reload Session’? 
If you do that, the editor will become rather boring: Every time you run it, the editor will open with initialized singles, patterns 
and multis loaded in the edit buffers and User Banks. 
 
There are bound to be users who might like the editor to work this way, however, so it’s always a valid set of options. 
 
 
 
 
This concludes the Vyzex Venom User’s Guide. As mentioned earlier on, it’s a good idea for you to also read the 
companion PDF manuals such as the Venom User Guide and the Vyzex Venom Preferences Guide for a more complete 
view of the preferences menu and how the editor’s control types operate. Just as with this document, these PDFs are 
accessible from the program’s Manuals pull down menu.  
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